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1. About FuncLab 

 FuncLab comprises a set of tools built within the MATLAB environment to 
analyze receiver functions (Eagar and Fouch, 2012).  Receiver functions are seismic time 
series computed by deconvolving the radial from the vertical seismogram to isolate the 
Earth’s radial S wave response.  While P-to-S conversions arrive later relative to the P 
wave, S-to-P conversions arrive earlier relative to the S wave.  Both mode conversions 
can be utilized in receiver functions for different purposes.  In this first release of 
FuncLab, tools are available for P-to-S receiver function analysis.  We note that S-to-P 
receiver function analysis could be incorporated via a community-developed add-on. 
 

These tools were developed on the Mac OS X platform beginning in 2006 with 
MATLAB 7.1.0.21 (R14) student version.  Most of the developed tools were created to 
be compatible with this version, but were not tested to be backwards compatible with 
earlier versions of MATLAB.  Figure dimensions may also vary from platform to 
platform, but reflect development on Red Hat Linux 5.3 running MATLAB 7.9.0 
(R2009b). Testing has also been conducted on Mac OS X 10.6.7 running MATLAB 
7.10.0 (R2010a) without problems. 
 
 There are some tools that are used within the toolkit that were not originally 
developed with FuncLab, but are borrowed from free open-source forums on the web.  
They are: 

1. ignoreNaN.m: used to handle NaN values within matrices  
2. makeColorMap.m: used to adjust color maps in figures 
3. mmpolar.m: creates a polar plot of ray parameter vs. backazimuth 
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2. Download and Setup 
 
 This section introduces the step-by-step instructions for downloading and setting 
up the M-files in the FuncLab package for your MATLAB session.  For the purposes of 
this manual, UNIX and MATLAB command line inputs are typed in courier font, file 
names and MATLAB variables are in italics, and directory names are bolded. 
 
 The FuncLab website, which includes the source code, a quick start guide, this 
manual, sample datasets, and links to needed external files is located at 
http://geophysics.asu.edu/funclab.  Download the latest release and untar it in the 
directory in which you would like to place the MATLAB M-files.  For example: 
 
tar –xvf funclab1.5.3.tar 
 
The directory funclab1.5.3 contains the files needed to run all the functions within the 
FuncLab toolbox.  Appendix A contains a list of all the M-files.  Note that data for 
mapping functions (requires the Mapping Toolbox) may be downloaded from outside 
data sources.  Links to these data and other relevant websites are provided in Appendix B 
of this manual and on the FuncLab website.  These data include DEM or topography such 
as ETOPO1, ETOPO2v2c, and GLOBE DEM, as well as GSHHS coastline data.  I 
recommend placing these under funclab1.5.3/map_data/. 
 
 In order to use the FuncLab functions, the user will need to add the paths to the 
files in the MATLAB session.  To perform this task, the user must change to the main 
funclab directory, and then run the setup_funclab script: 
 
cd funclab1.5.3 
setup_funclab 
 
The setup_funclab script automatically adds all the directories to the search paths in 
MATLAB.  In addition, this script checks for the Mapping and Signal Processing 
Toolboxes on the machine.  If these are installed, certain functions will be available for 
use.  However, if they are not installed, some functions may not be available.  If the user 
has administrative rights on the machine running FuncLab, they may choose to insert the 
full pathname of the setup_funclab script to the startup.m file, located under the 
MATLAB application directory.  See MATLAB documentation for startup.m for 
specifics (see http://www.mathworks.com/help/techdoc/ref/startup.html).  This will then 
enable setup_funclab to run automatically at the start of MATLAB.  FuncLab is 
now ready to be used on your machine.  
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3. Receiver Function Overview, Preparation, and Raw Data Directory 
Structure 
 
3.1 Receiver Function Overview 
 
 P-to-S converted waves (Pds) that arrive directly after the P wave provide 
information about velocity and density discontinuities in the Earth below seismic stations.  
These phases may be investigated directly on the horizontal components if the recorded 
earthquakes have simple impulsive source-time functions.  However, many earthquake 
source wavelets are complicated and generally unknown.  Since the Pds arrivals lie 
within the coda of the P wave and have amplitudes an order of magnitude smaller, 
stacking many records together to enhance the signal-to-noise ratio is necessary.  Both 
Langston (1979) and Vinnik (1977) recognized the need for an approach to compare 
converted phases from events with different source signals and developed similar 
methods for isolating the SV from the P wave signal and removing the influence of the 
source signal from the seismograms.  The receiver function therefore represents the 
Earth’s impulse response, containing time and amplitude information that is sensitive to 
the local earth structure beneath a station.  We refer the reader to Langston (1979) and 
Vinnik (1977) for further details on method, theory, and development. 
 
 There are several choices in source normalization procedures to isolate the SV 
energy, including the choices of coordinate system and deconvolution method.  
Regarding the choice of the coordinate system, Langston (1979) rotated the horizontal 
component seismograms along the free surface to point in the radial and tangential 
directions from the backazimuth of the earthquake (ZRT coordinate system).  Vinnik 
(1977) performed a more complete rotation to the LQR coordinate system, where the 
radial component includes the raypath of the incident wave in the radial direction 
assuming a slowness vector from a 1-D Earth model.  Bostock (1996) improved on the 
method of Vinnik (1977) by maximizing the SV wave energy using slowness as a function 
of time from the radial and vertical components’ covariance matrix over a given time 
window.  Although these successively improve upon each other, it is still difficult to 
achieve full P-SV wavefield separation and all methods represent an approximation.  For 
the purposes of most imaging, however, this approximation is acceptable, as the signal of 
the Pds is visible with any of these rotation choices.  
 
 The second choice in source normalization involves the deconvolution method of 
the source from the seismograms.  Deconvolution can either be performed in the 
frequency domain or the time domain.  The most common method is done in the 
frequency domain, but requires water-level stabilization to eliminate spectral holes that 
result from division by zero in the frequency domain (Clayton and Wiggins, 1976).  
Although the algorithm is computationally fast, it has the disadvantage of requiring the 
user to manually search for the optimal water-level while trying to minimize the loss of 
spectral information.  Side-lobes on Pds arrivals are also an adverse consequence of 
spectral leakage from this regularization method.  An alternative frequency-domain 
method is the multi-taper method, which reduces the loss of spectral information, but 
requires greater computation (Park and Levin, 2000).  Time-domain methods include 
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matrix inversions (e.g., Abers et al., 1995; Gurrola et al., 1995; Sheehan et al., 1995), 
which also require regularization in the form of damping parameters, and the iterative 
deconvolution method of Ligorria and Ammon (1999), which is more appropriately 
characterized as a predictive convolution that produces truly causal signals with no loss 
of spectral information. 
 
 
3.2 Receiver Function Format and Preparation 
 
 In order for FuncLab to function in a more general sense with publicly available 
data, certain choices were necessary regarding data formats and directory structures.  The 
current version is only capable of importing seismic data that is in the SAC format 
(http://www.iris.edu/software/sac/manual.html).  It can read and handle SAC files that are 
either little endian or big endian byte-order automatically.  It also requires a specific 
directory structure for the seismic data import and the creation of a new FuncLab project 
(next section).  This directory structure originated from the output of publicly available 
data download using the Standing Order for Data (SOD) program 
(http://www.seis.sc.edu/sod/). 

 
The choice of pre-processing methods to obtain receiver functions is independent 

of FuncLab and is left up to the user.  Our choice of deconvolution schemes is an iterative 
deconvolution receiver function code written by Charles Ammon at Penn State 
University (http://eqseis.geosc.psu.edu/~cammon/HTML/RftnDocs/rftn01.html).  
FuncLab is thus written assuming that the receiver function output will be similar to that 
for this iterative deconvolution package. The link to download this code is also posted on 
the FuncLab website.  Also posted are some generic C-shell scripts used to run the 
preprocessing of data in this directory structure and output filenames appropriately to 
help ensure that receiver functions are produced in a way in which FuncLab can read 
them. We also note that the EarthScope Automated Receiver Survey (EARS) data 
product (http://ears.iris.washington.edu/) provides receiver functions that can be used in 
FuncLab using the script EARS2FL.csh, also included in this release.  For a more 
complete description of SAC file formats and header descriptions, see Appendix C. 
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3.3 Receiver Function Raw Data Directory Structure 
 

The raw data directories should be structured in the follow manner: 
 

 
 
Receiver function files begin with the station name/code, contains the Gaussian 
parameter used to compute the receiver function, and ends with i.eqr (radial) or i.eqt 
(transverse).  Files for both the radial and transverse receiver functions must be included 
for completeness. Also, it is helpful to include the radial, transverse, and vertical 
seismograms to exploit some of the seismogram viewing features within the FuncLab 
toolbox.  All five files are required for a single event-station pair. 
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4. Graphical User Interface 
 
 To begin, the user invokes the main FuncLab GUI using the funclab command in 
MATLAB.  From this interface, the user may start a new project or load an existing one.  
 

 
 
 
4.1 Starting a new project 
 

To begin by starting a new project, where the data has already been pre-processed 
outside of FuncLab, select File→New Project from the top menu. 
 

 
 
The “New FuncLab Project Setup” interface will appear.  From here, the user will first 
determine the directory for the new project.  This directory must not exist, as FuncLab 
will create and populate it with the necessary files and sub-directories for the project.  Up 
to 10 separate data directories, formatted in the required structure as discussed above, can 
be imported at the initiation of the project.  The user may either enter these directories 
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manually in the specified boxes, or browse for these directories on the computer.  After 
entering as many data directories as the user wishes to import for this project (up to 10, 
but more can be added once the project is created), the user hits the Start button.  
FuncLab, at this point will create the new project directory with some sub-directories, 
copy the data directories into the project directory and populate the new Project.mat file 
that will handle most of the metadata for interaction with the GUI. 
 

 
 
4.2 Loading an Existing Project 
 

If you are working from an existing FuncLab project, you can load the data into 
FuncLab by select File→Load Project from the top menu. 
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Select the Project.mat file that is contained one level into the existing Project directory 
and select Open.  The main FuncLab GUI will open with your project and you are ready 
to begin. 
 
 
4.3 Project.mat File and FuncLab Variables 
 
 FuncLab saves the metadata for each station-earthquake pair of waveform files in 
the Project.mat MAT-file.  Metadata for the records are organized into a cell array 
variable called RecordMetadataStrings and a double array variable called 
RecordMetadataDoubles, where each column contains different information such as 
station name, event origin time, waveform sample rate, etc. 
 
 
4.3 Main FuncLab GUI 
 
 The main FuncLab GUI allows the user to interact with the entire dataset.  The 
GUI includes four top menus; File, Editing, View, and Add-ons.  A drop-down menu in 
the top-left defines the manner in which receiver function metadata is organized for 
visualization in the GUI (we refer to these as tables, although this is not a formal 
relational database system).  Records common to a particular station are viewed in 
“Station Tables”.  The stations are then listed and selectable in the left-hand panel.  
Below this panel is listed the total number of tables displayed.  The records within the 
“Station Table” are listed by the event origin time in the center panel.  The total number 
of records and number of active records are listed below the panel.  Information or 
metadata about the selected record in the center panel are then listed in the right-hand 
panel.  These include station and event information, time series information, and the path 
of the SAC files for the record. 
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The user can also view the records organized by event origin by selecting the “Event 
Tables” in the drop-down menu.  Other options in the drop-down menu become available 
when using add-on analysis tools discussed below. 
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The user can also view the records organized by event origin by selecting the “Event 
Tables” in the drop-down menu.  Other options in the drop-down menu become available 
when using add-on analysis tools discussed below. 

 
The File menu contains options that control FuncLab and projects as a whole, 

such as starting or loading projects, adding data, and changing preferences.  New data 
may be added to an existing project by selecting File→Add Data from the top menu.  
 

 
 
FuncLab preferences control certain aspects of all the plotting functions, such as 

time axis parameters, backazimuth and ray parameter axis parameters, and mapping 
parameters.  These are accessed through the File→FuncLab Preferences menu item.  
Adjustments of map boundaries and axis settings from the defaults are likely required 
depending on the imaging target of the receiver function study. 
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A log file keeps information about each process performed on the dataset.  The 

log file can be viewed from the main FuncLab GUI using the menu File→Log File.  This 
is a text file that is initiated when the project is first created.  Dates and times of 
processes are logged, as well as the name of the process and certain preferences set to run 
the process.  This is not editable in the GUI and is intended for user guidance. 

 

 
 
 
4.4 Trace Editing 

From the main FuncLab GUI, the Trace Editor can be accessed through the 
Editing menu, which contains options for manual and automated trace editing.  The first 
step that should be performed is setting the trace editing preferences.  These can be 
accessed through Editing→Trace Editing Preferences.  These control aspects of the GUI 
display such as receiver function component (radial or transverse), time axis parameters, 
gain, number of receiver functions in the view, and sample rate for resampling.  Other 
preferences, such as the maximum amplitude and the minimum receiver function fit, can 
be specified as control parameters in automated trace editing. 
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Opening the Manual Trace Edit GUI will read in the receiver function SAC files 

of the records in the selected table in the left-hand panel. The Trace Editing GUI displays 
the receiver functions as wiggle traces with time increasing down the y-axis and each 
record one unit wide across the x-axis.  The scrollbar at the bottom allows the user to 
scan through records in the table to display them in the window.  The record status is 
changed in the “Status” column of RecordMetadataDoubles and saved to Project.mat at 
the end of the trace editing session.  Each record has a checkbox above it, which is used 
to select the status of the record (check means “on” and no check means “off”).  The 
ability to change a record’s status allows the user to specify good records that will be 
used in future analyses (i.e., stacking and visualization processes) and ignore bad records.  
Records with status “off” remain part of the dataset and are not deleted from the project.  
The color of the wiggle traces is another indicator of the record’s status. New data that 
have not yet been evaluated through the Trace Editor are colored red, whereas data that 
has been looked at in the GUI before are colored blue.  All records with status “off” are 
shaded gray. 
 

 

 
 

Furthermore, right-clicking the waveform brings up a menu to start another GUI 
for visualizing the seismograms and radial receiver function, change the record status, 
and displays event and record information useful in determining the appropriate status of 
the record (Figure 7).  The record status is changed in the “Status” column of 
RecordMetadataDoubles and saved to Project.mat when the Save Edits button is 
selected. 
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 Automated trace editing can be performed on a selected table (Editing→Auto 
Trace Edit – Selected) or the entire dataset (Editing→Auto Trace Edit – ALL).  The 
second criteria is a minimum fit or measure of uncertainty in the receiver function, 
expected to be set in the USER9 SAC header. 
 

   
 
 
4.5 Viewing Data (Plots and Visualizations) 
 A number of data plotting functions are located under the View menu in the main 
FuncLab GUI and are divided into three sections.  The top section displays plots related 
to the selected record in the center panel.  Options in the middle section display plots of 
active records in the selected table in the left-hand panel.  The bottom section includes 
visualizations that involve active and inactive records within the dataset. 
 

 
 
The Seismograms, Record Section, and Stacked Records items plot the vertical, radial, 
and transverse seismograms and radial and transverse receiver functions.  Note that the 
record section plot is more effective when switching to “Event Tables” and highlighting 
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an event, rather than a particular station.  A quick method of QC and trace editing your 
data maybe to look at these plots by event, then by right clicking the event table, you can 
select either “Turn On” or “Turn Off” to edit all records in that event. 
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The RF Moveout Record Section item plots receiver function wiggle traces of active 
records vs. ray parameter, and the RF Moveout Image plot the vertical, radial, and 
transverse seismograms and radial and transverse receiver functions. The RF Moveout 
Record Section item plots receiver function wiggle traces of active records vs. ray 
parameter, and the RF Moveout Image stacks records into ray parameter bins and displays 
the amplitudes by a color scale. 

 
 

 
RF Backazimuth Record Section and RF Backazimuth Image are similar except that 
records are displayed vs. backazimuth. 
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The Dataset Statistics item is not a true plot or visualization, but displays a textbox 
summarizing various statistics, such as the number of total active records, about the 
dataset.  Another data coverage visualization is the Ray Parameter/Backazimuth Diagram 
which plots these metadata on a polar plot.  Finally, two map options, a Station Map and 
a Global Event Map, are available if the MATLAB Mapping Toolbox is installed. 
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5. Project Directory Structure and Description 
 
 A FuncLab “project” defines an entire dataset to be analyzed.  It can contain 
multiple data directories as defined in section 3. A project directory contains all the raw 
data used by FuncLab, as well as files and directories it creates when a user initiates a 
new project.  A new project is created within the FuncLab GUI by importing at least one 
data directory of the structure defined in section 3.  The following shows the structure of 
the automatically generated project directory: 
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RFPROJECT (this is a generic name given for the purposes of illustration) is the top 
directory name, which the user specifies at the onset of a new project.  The RAWDATA 
directory contains all the data directories that a user imports into the project.  Notice that 
these are of the same structure as described in the previous section.  The Logfile.txt is a 
text file that is used to store a log of all the processes run within FuncLab on a specific 
project.  It contains a description of the process, parameters used, and time stamps.  This 
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is generated automatically and can be useful when retrieving a record of the different runs 
for each process.  The Project.mat file is a MATLAB formatted data file that contains all 
the MATLAB variables used to reference the raw seismic data and metadata within a 
project.  It is essentially the key “database” of the project.  There are also variables 
contained in Project.mat that are used to communicate with the different GUIs of 
FuncLab and keep them talking to one another. 
 
 Other directories will be added under RFPROJECT/ once certain add-on 
packages are initiated with a project.  These new directories are CCPDATA/, 
GCCPDATA/, and HKDATA/.  Each of these contains MAT-files storing variables 
created in MATLAB specific for the types of analyses performed.  For example, the 
CCPDATA/ directory contains CCPData.mat which stores variables that define the CCP 
grid and ray tracing information for each receiver function used in the stacks.  It also 
contains a separate MAT-file for each CCP bin (e.g. Bin_1_000360_040080.mat) that 
stores variables defining the CCP stack for that bin.  This is similar for GCCPDATA/.  
The HKDATA/ directory contains a separate MAT-file for each H-κ stack (e.g. 
TA_F10A_000360_040080.mat).  The first and second set of numbers in the bin and H-κ 
stack files refers to the backazimuthal range and ray parameter range in the stacking, 
respectively. 
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6. Model Building and Setup 
 
 
6.1. Velocity Models 
 

FuncLab is currently only designed to handle 1D Earth models in a very simple 
way.  This version of the package contains three commonly used 1D models: PREM 
(Dziewonski and Anderson, 1981), IASP91 (Kennett and Engdahl, 1991), and AK135 
(Kennet et al., 1995).  These are contained under the funclab1.5.1/VELMODELS/ 
directory within the text files PREM.vel, IASP91.vel, and AK135.vel, respectively.  Each 
contains three columns, where column 1 is depth, column 2 is Vp, and column 3 is Vs.  
Each row represents a new depth shell beginning at the depth defined in column 1. 

 
Other models can easily be built to use in FuncLab.  In order for FuncLab to 

recognize these, however, it is necessary to place the new velocity models in text files 
under the funclab1.5.3/VELMODELS/ directory and with the extension .vel. 
 
 
6.2. Tomography Models 
 
 Certain analysis packages, such as CCP and GCCP stacking, can utilize seismic 
tomography models for timing corrections with receiver function time-to-depth 
conversions or migrations.  This version of FuncLab is distributed with a P-wave 
tomography model of the Pacific Northwest published in West et al. (2009) and used for 
CCP stacking analysis in Eagar et al. (2010).  It is placed under the 
funclab1.5.3/TOMOMODELS/ directory in the MAT-file NWUS_P09b_1-2.mat.  This 
file stores 6 variables used to define the model: Depths, Lons, Lats, ModelP, ModelS, and 
TomoType.  The first 5 are 3x3 matrices, where the first, second, and third dimensions 
define x,y, and z (longitudes, latitudes, and depth) of the 3D volume.  The ModelP and 
ModelS variables define the P- and S-wave perturbations or velocities, respectively at 
each point in the volume.  TomoType either defines the model as a “perturbation” model 
or a “velocity” model to handle differencing the volume from the 1D velocity model used 
in the ray tracing. 
 
 As with velocity models, other tomography models can be built to be used in 
FuncLab.  These new models should be place under the funclab1.5.3/TOMOMODELS/ 
and have the extension, .mat. 
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7. Add-on Packages 
 
 These are special code packages that are optional with FuncLab running as the 
base.  For instance, common-conversion point (CCP) stacking of receiver functions to 
look at mantle discontinuities is a common approach.  Similarly, H-κ stacking of receiver 
functions for examining Moho depth and crustal Vp/Vs is another common analysis. 
FuncLab includes add-on packages for both of these analyses.  Although these add-on 
packages are integrated with FuncLab, it is also separate from the FuncLab main code.  
This means that a core add-on package does NOT have to be altered to change things 
associated with the CCP package.  Here we describe how to develop separate add-on 
packages for additional receiver function processing. 
 
 There is a specific directory structure needed for an add-on as well as a specific 
location relative to the FuncLab directories.  In funclab.m, the path of the funclab 
command is searched for.  That path should be the same path that the flab directory is 
housed.  This is the directory that contains the entire core FuncLab code. Place the add-
on directory in the addons subdirectory.  For example, the ccp directory contains all the 
codes for the CCP add-on. All add-on code must be in a single subdirectory.  FuncLab 
will not recognize any subdirectories beneath the main one (such as addons > ccp > 
working).  As a point of organization, FuncLab includes m-files with the prefix of the 
add-on directory (e.g. ccp_assign.m). 
 
 The next component is an m-file under this add-on directory called init_{add-
on}.m.  Replace {add-on} with the name of the add-on.  In the CCP add-on case, it would 
be called init_ccp.m.  This file need only contain 1 line that looks like this: 
 
uimenu(MAddons,'Label','Common-Conversion Point 
Stacking','Tag','ccp_m','Enable','off','Callback',{@ccp_Callback}); 
 
The string after ‘Label’ is the name to be listed under the “Add-ons” toolbar in the main 
FuncLab GUI.  ‘Tag’ should just be a unique name.  In FuncLab, the add-on name is a 
prefix and the letter “m” which stands for “main”.  ‘Enable’ should ALWAYS be off.  
‘Enable’ is turned on eventually, but must be initialized as “off”.  The ‘Callback’ is 
followed by {@{add-on}_Callback} and is important. This refers to a function (or m-file) 
by the same name. 
 
 This brings us to the third required component: a callback function that transfers 
the FuncLab GUI handles to your add-on GUI.  This is essential to connecting the core 
package with the add-on.  This callback function must be named {add-on}_Callback.m 
and must be in the add-on directory.  As before, replace {add-on} with its proper name.  
In the CCP example, it is called ccp_Callback.m.  It must contain 4 lines of code as 
follows: 
 
function ccp_Callback(cbo,eventdata,handles) 
h = guidata(gcbf); 
Project = get(h.project_t,'string'); 
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ccp(h) 
 
Replace “ccp_Callback” with the name of the new callback function, and replace 
“ccp(h)” with the m-file that begins the add-on GUI.  The input “h” is the FuncLab GUI 
handles that MUST pass to the Add-on GUI for things to work properly. 
 
 The final step is to create this m-file that calls the Add-on GUI.  It can have any 
structure.  The only difference is that when you want to use handles that are associated 
with the main FuncLab GUI, you must refer to them in the input structure array.  This is 
clearer using the examples provided with this manual. 
 
 The CCP GUI contains editable parameters on the left-hand side and functional 
pushbuttons for data processing on the right-hand side.  1-D ray tracing creates the 
RayMatrix_XX and MidPoints_XX matrices that store the ray coordinates at each depth 
increment and half-depth increment, respectively.  The XX is included in the matrix name 
to account for the possibility that more than one matrix may need to be generated, since 
each matrix is allowed to store up to 25,000 records to save memory in MATLAB.  Both 
variables are stored in the CCPData.mat MAT-file under the created subdirectory in the 
project directory, CCP.  The correction for 3-D heterogeneity is an optional step and 
requires the user to choose a tomography model, which can be defined or imported by the 
user as explained in the user manual.  The MidPoint_XX matrix will be populated with 
timing corrections as described in Eagar et al. [2010] and are stored in the 
TimeCorrections_XX matrix, also saved to CCPData.mat.  Time-to-depth conversion 
saves receiver function amplitudes in RayMatrix_XX that are now associated with each 
ray coordinate and depth increment.  Each CCP bin saved in the CCPGrid matrix is 
assigned the amplitudes associated with it at each depth increment.  CCP stacking results 
in the creation of two new arrays to store the CCP metadata, CCPMetadataStrings and 
CCPMetadataDoubles, which are saved to the Project.mat file.  The stacking function 
also adds a row to the Tablemenu variable in the Project.mat file to control the drop-
down menu in the main FuncLab GUI and allow the user to view records of CCP bins in 
the same manner as receiver function records. 
 

 
 
 The GCCP GUI is quite similar to the CCP GUI with only a few minor 
differences, such as the choice of the Gaussian width parameter and weights, which are 
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stored in the RayMatrix_XX variable.  In all other variables and functions, CCP is 
replaced with GCCP.  M-files for this add-on are found in the subdirectory addons/gccp. 
 
 Algorithms for H-κ stacking are included in m-files found in the subdirectory 
addons/hk. To perform a single station stack, the user selects the “H-κ Stack (Single 
Station)” button.  All active records from the station selected from the station tables in the 
main FuncLab GUI will be stacked based on the parameters selected on the left-hand side 
of the H-κ Stacking Analysis GUI.  Stacking one or all stations will create the 
HkMetadataStrings and HkMetadataDoubles arrays to store metadata for each H-κ stack 
that will be saved to the Project.mat file.  Several visualizations to aid the user in the 
analysis are included in the package. 
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APPENDIX A. 

 
LIST OF M-FILES 

 
setup_funclab.m 
funclab.m 
 
addons 
 ccp 
  ccp_1D_raytracing.m 
  ccp_assign.m 
  ccp_binmap.m 
  ccp_binstack.m 
  ccp_bootstrap.m 
  ccp_Callback.m 
  ccp_corrections.m 
  ccp_ex_pp.m 
  ccp_ex_stacks.m 
  ccp_fieldnames.m 
  ccp_migration.m 
  ccp_readamps.m 
  ccp_record_fields.m 
  ccp_setup_grid.m 
  ccp_stacking.m 
  ccp.m 
  init_ccp.m 
 gccp 
  gccp_1D_raytracing.m 
  gccp_assign.m 
  gccp_binmap.m 
  gccp_binstack.m 
  gccp_bootstrap.m 
  gccp_Callback.m 
  gccp_corrections.m 
  gccp_ex_pp.m 
  gccp_ex_volume.m 
  gccp_fieldnames.m 
  gccp_migration.m 
  gccp_readamps.m 
  gccp_record_fields.m 
  gccp_setup_grid.m 
  gccp_stacking.m 
  gccp.m 
  init_gccp.m 
 hk 
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  hk_allstack.m 
  hk_Callback.m 
  hk_ex_grids.m 
  hk_ex_solutions.m 

hk_record_fields.m 
  hk_singlestack.m 
  hk_view_baz_image.m 
  hk_view_hkgrid.m 
  hk_view_moveout_image.m 
  hk_view_stacked_records.m 
  hk.m 
  init_hk.m 
custom 
 errordlg_kce.m 
 movegui_kce.m 
 questdlg_kce.m 
 uigetdir_kce.m 
 uigetfile_kce.m 
flab 
 fl_add_data_gui.m 
 fl_add_new_data.m 
 fl_datainfo.m 
 fl_datastats_gui.m 
 fl_default_prefs.m 
 fl_edit_logfile.m 
 fl_init_logfile.m 
 fl_log_gui.m 
 fl_pref_fieldnames.m 
 fl_preferences_gui.m 
 fl_readseismograms.m 
 fl_record_fields.m 
 fl_traceedit_gui.m 
 fl_view_baz_image.m 
 fl_view_baz.m 
 fl_view_data_coverage.m 
 fl_view_event_map.m 
 fl_view_moveout_image.m 
 fl_view_moveout.m 
 fl_view_record_section.m 
 fl_view_record.m 
 fl_view_stacked_records.m 
 fl_view_station_map.m 
 te_default_prefs.m 
 te_pref_fieldnames.m 
 te_preferences_gui.m 
 te_view_record.m 
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map_utilites 
 azimuth.m 
 deg2km.m 
 deg2rad.m 
 gg2gc.m 
 km2deg.m 
 latlon_from.m 
 rad2deg.m 
utilities 
 colvector.m 
 ignoreNaN.m 
 makeColorMap.m 
 mmpolar.m 
 skm2srad.m 
 srad2skm.m 
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APPENDIX B. 
 

WEBSITE REFERENCES 
 
Seismic Analysis Code (SAC): http://www.iris.edu/software/sac/manual.html 
 
Standing Order for Data (SOD): http://www.seis.sc.edu/sod/ 
 
Receiver Function Codes (Charles Ammon, Penn State): 
http://eqseis.geosc.psu.edu/~cammon/HTML/RftnDocs/thecodes01.html 
 
Generic Mapping Tools (GMT): http://www.soest.hawaii.edu/gmt/ 
 
Earthscope Automated Receiver Survey (EARS): http://ears.iris.washington.edu/ 
 
MATLAB Mapping Data: 

• Coastlines 
o gshhs_2.1.1: 

http://www.ngdc.noaa.gov/mgg/shorelines/data/gshhs/version2.1.1/gshhs_
2.1.1.zip 

• Topography 
o 1-arc-minute DEM 

ETOPO1_ice_c_i2 (Ice Surface): 
http://www.ngdc.noaa.gov/mgg/global/relief/ETOPO1/data/ice_surface/ce
ll_registered/binary/etopo1_ice_c_i2.zip 
ETOPO1_bed_c_i2 (Bedrock Surface): 
http://www.ngdc.noaa.gov/mgg/global/relief/ETOPO1/data/bedrock/cell_r
egistered/binary/etopo1_bed_c_i2.zip 

o 2-arc-minute DEM 
ETOPO2v2c_i2_MSB: 
http://www.ngdc.noaa.gov/mgg/global/relief/ETOPO2/ETOPO2v2-
2006/ETOPO2v2c/raw_binary/ETOPO2v2c_i2_MSB.zip 

o 30-arc-second (1-km) grid DEM 
GLOBE DEM: 
http://www.ngdc.noaa.gov/mgg/topo/DATATILES/elev/all10g.zip 
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APPENDIX C. 
 

DESCRIPTION OF SAC FILES 
 
SAC files for the receiver functions and seismograms may be produced in a variety of 
ways, but regardless of the method of preprocessing, some important formatting 
standards must be followed.  This appendix describes the format and headers needed in 
each of the files. 
 
FuncLab imports 5 separate SAC files for a given calculated receiver function.  These 
include the vertical seismogram, radial seismogram, transverse seismogram, radial 
receiver function, and transverse receiver function.  It is preferred that all 5 files are time 
synched to the zero time of the receiver functions.  This makes plots in FuncLab make a 
lot more sense and prevents issues when interpreting the time axis. 
 
Naming of the SAC files is an important first step.  All SAC files have a naming 
convention as follows: 
 
 STA_2.5.i.z, 
 
where "STA" is the station name, "2.5" represents the Gaussian lowpass filter (or any 
type of lowpass filter used), "i" means that we used "iterative deconvolution" to calculate 
the receiver function, and "z" is the seismogram component of motion.  The station name 
and the extension are the most important items of the name.  The extensions define the 
type of file as follows: 
 
 .z = vertical seismogram 
 .r = radial seismogram 
 .t = transverse seismogram 
 .eqr = radial receiver function 
 .eqt = transverse receiver function. 
 
The SAC header definitions and descriptions for the seismograms are below: 
 

NPTS = 4401 
(number of points in seismogram) 

B = -1.000000e+01 
(beginning time of seismogram) 

E = 1.000000e+02 
(end time of seismogram) 

IFTYPE = TIME SERIES FILE 
(defines the type of file) 

LEVEN = TRUE 
(defines the sampling of the seismogram as “even” – this is a MUST) 

DELTA = 2.500000e-02 
(sample rate of the seismogram) 
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IDEP = UNKNOWN 
(type of dependent variable – not necessary for our purposes although we 
assume it is a velocity seismogram) 

DEPMIN = -1.740033e+02 
(minimum amplitude in seismogram) 

DEPMAX = 1.473583e+02 
(maximum amplitude in seismogram) 

DEPMEN = 8.144172e-01 
(mean amplitude in seismogram) 

OMARKER = -721.03 
(number of points in the time series) 

T1MARKER = 0                (P) 
(arrival time and marker of predicted P wave – this needs to be set as your 
zero time for the seismograms) 

KZDATE = AUG 14 (227), 2008 
(origin date of earthquake) 

KZTIME = 00:18:41.200 
(origin time of earthquake) 

IZTYPE = BEGIN TIME 
(defines the reference time for this file – needs to be set to BEGIN TIME) 

KSTNM = G08A 
(station code) 

CMPAZ = 0.000000e+00 
(component of motion azimuth – needs to be 0 for vertical, BAZ-180 for 
radial and radial RFs, and BAZ-90 for transverse and transverse RFs) 

CMPINC = 0.000000e+00 
(component of motion inclination – needs to be 0 for vertical and 90 for 
radial or transverse, including RFs) 

STLA = 4.529040e+01 
(station latitude) 

STLO = -1.189595e+02 
(station longitude) 

STEL = 1.318000e+03 
 (station elevation in meters) 
STDP = 0.000000e+00 
 (station depth in meters) 
EVLA = 1.640000e+01 
 (earthquake latitude) 
EVLO = 1.469000e+02 
 (earthquake longitude) 
EVEL = 0.000000e+00 
 (earthquake elevation in meters) 
EVDP = 5.300000e+04 
 (earthquake depth in meters) 
DIST = 9.048033e+03 

(distance in kilometers from station to earthquake) 
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AZ = 4.540545e+01 
 (azimuth from earthquake to station) 
BAZ = 2.844766e+02 
 (backazimuth from station to earthquake) 
GCARC = 8.138271e+01 
 (distance in degrees from station to earthquake) 
LOVROK = TRUE 
 (set to TRUE to overwrite the file) 
USER0 = 2.500000e+00 
 (Gaussian parameter used to compute iterative deconvolution RF – see 

description of process below) 
USER1 = 3.028038e+02 
 (predicted P wave ray parameter in sec/rad) 
USER8 = 0.000000e+00 
 (predefines the trace edit status – this is OPTIONAL, but set to 0 if it is 

bad or 1 if it is good and you want to define it as an active RF) 
USER9 = 6.000000e+01 
 (fit or match of the predicted waveform from iterative deconvolution – see 

description of process below) 
NVHDR = 6 
 (header version number – current version is 6) 
LPSPOL = TRUE 
 (set to TRUE if component has positive polarity) 
LCALDA = TRUE 
 (set to TRUE if DIST, AZ, BAZ, and GCARC are calculated from 

station/earthquake coordinates) 
KCMPNM = BHZ 
 (component code – should be set to BHZ for vertical, BHR for radial and 

radial RFs, and BHT for transverse and transverse RFs) 
KNETWK = TA 
 (network code) 
MAG = 5.500000e+00 

(earthquake body wave magnitude) 
 

One note of caution: the CMPINC specifications in the description assume that the 
seismograms have been rotated in the direction of the earthquake along the plane of the 
surface.  Rotations into true radial and transverse along the back-projected ray path will 
have a different inclination. 
 
The iterative deconvolution code computes a receiver function by first performing a 
cross-correlation on the vertical and radial seismogram.  Then, based on the lag time, 
convolves a spike train that represents that lag time with a Gaussian function.  The 
Gaussian parameter determines the width of the Gaussian wavelet and essentially acts as 
a low-pass filter for the receiver function.  After the first pulse is generated on the 
predicted receiver function, the receiver function is convolved with the vertical 
seismogram to get a predicted radial seismogram.  The difference between the predicted 
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radial and the data is then computed to get a residual.  As long as the residual is greater 
than a given threshold, the process continues.  The first pulse is stripped and the next 
pulse is generated, again by the process of cross-correlation, convolution with a Gaussian 
wavelet to produce a predicted receiver function, and convolution of the receiver function 
with the vertical seismogram.  More details can be found in Ligorria and Ammon, 1999. 
 


